
INSTRUCTIONS FOR AUTHORS (2010) 

GENERAL 
The Journal of the Serbian Chemical Society is an international journal publishing papers from all fields of 

chemistry and related disciplines. Twelve issues are published annually. The Editorial Board expects the editors, 
reviewers and authors to respect the well-known standard of professional ethics. 

Types of Contributions 
Original scientific papers (about 10 typewritten pages) report original research which must not have been

previously published.
Short communications (about 5 pages) report unpublished preliminary results of sufficient importance to merit 

rapid publication.
Notes (about 3 pages) report unpublished results of short, but complete, original research. 
Authors’ reviews (about 30 pages) present an overview of the author’s current research with comparison to 

data of other scientists working in the field.
Reviews (about 30 pages) present a concise and critical survey of a specific research area. 

Generally, these are prepared at the invitation of the Editor.
Book and Web site reviews (1–2 pages) 
Extended abstracts (about 3 pages) of Lectures given at meetings of the Serbian Chemical Society Divisions. 

Submission of manuscripts 
Manuscripts should be submitted using the OnLine Submission Form, available on the JSCS Web Site 

(www.shd.org.rs/JSCS/Form/). The manuscript must be uploaded as a Word.doc or .rtf file (tables and figures should 
follow the text, each on a separate page). Illustrations in TIF or EPS format (JPG format is acceptable for colour and 
greyscale photos, only), must be additionally uploaded as a separate archived (.zip, .rar or .arj) file. Figures and/or 
Schemes should be prepared according to the Artwork Instructions. 

Manuscripts must be accompanied by a cover letter in which the type of the submitted manuscript and a 
warranty as given below are given. The Author warranties that the manuscript submitted to the Journal for review is 
original, has been written by the stated authors and has not been published elsewhere; is currently not being 
considered for publication by any other journal and will not be submitted for such a review while under review by the 
Journal; the manuscript contains no libellous or other unlawful statements and does not contain any materials that 
violate any personal or proprietary rights of any other person or entity. All manuscripts will be acknowledged on 
receipt (by e-mail) and given a reference number, which should be quoted in all subsequent correspondence. A 
password for “Article Tracking” (www.shd.org.rs/JSCS/) will also be supplied. 

A MANUSCRIPT NOT PREPARED ACCORDING TO THESE INTRUCTIONS WILL BE RETURNED 
FOR RESUBMITION WITHOUT BEING ASSIGNED A REFERENCE NUMBER. 

PROCEDURE 
All contributions will be peer reviewed and only those deemed worthy will be accepted for publication. The 

Editor has the final decision. To facilitate the reviewing process, authors are encouraged to suggest up to three persons 
competent to review their manuscript. Such suggestions will be taken into consideration but not always accepted. 

Manuscripts requiring revision should be returned according to the requirement of the Editor, within 60 days or 
the manuscript will be considered as having been withdrawn. Later, the manuscript would have to be resubmitted. 

The Journal maintains its policy and takes the liberty of correcting the English of manuscripts scientifically 
accepted for publication.  

When a manuscript is ready for printing, the corresponding author will receive a PDF-formatted manuscript for 
proof reading, which should be returned to the Journal within 2 days. Failure to do so will be taken as the authors are 
in agreement with any alteration which may have occurred during the preparation of the manuscript. 

Accepted manuscripts of active members of the Serbian Chemical Society (all authors) have publishing priority. 
The corresponding author will receive by e-mail a PDF-formatted version of the paper as published in the 

journal. 
MANUSCRIPT PRESENTATION 

Manuscripts should be typed in English (either standard British or American English, but consistent throughout) 
with 1.5 spacing (12 points Times New Roman; Greek letters in the character font Symbol) in A4 format leaving 2.5 
cm for margins. For Regional specific, non-standard save documents with Embed fonts Word option: Save as -> 
(Tools) -> Save Options… -> Embed fonts in the text. 

The authors are requested to seek the assistance of competent English language expert, if necessary, to ensure 
their English is of a reasonable standard. The Serbian Chemical Society can provide this service in advance of 
submission of the manuscript. If this service is required, please contact the office of the Society by e-mail (jscs-
info@shd.org.rs). 

Tables and figures and/or schemes should not be embedded in the manuscript but their position in the text 
indicated. In electronic version (Word.doc document) tables and figures and/or schemes should follow the text, each 
on a separate page. Please number all pages of the manuscript including separate lists of references, tables and figures 
and their captions. 

 



IUPAC recommendations for the naming of compounds should be followed. SI units, or other permissible units, 
should be employed. The designation of physical quantities must be in italic throughout the text (including figures, 
tables and equations), whereas the units are in upright letters. They should be in Times New Roman font. In graphs 
and tables, a slash should be used to separate the designation of a physical quantity from the unit (example: p / kPa, t / 
°C, T / K, τ / h…). Designations such as: p (kPa), t [min]…, are not acceptable. However, if the full name of a 
physical quantity is unavoidable, it should be given in upright letters and separated from the unit by a comma 
(example: Pressure, kPa, Temperature, K…). Please do not use the axes of graphs for additional explanations; these 
should be mentioned in the figure captions and/or the manuscript (example: “pressure at the inlet of the system, kPa” 
should be avoided). The axis name should follow the direction of the axis (the name of y–axis should be rotated by 
90°). Top and right axes should be avoided in diagrams, unless they are absolutely necessary. 

Latin words, as well as the names of species, should be in italic, as for example: i.e., e.g., in vivo, ibid, 
Calendula officinalis L., etc. The branching of organic compound should also be indicated in italic, for example,  
n-butanol, tert-butanol, etc. 

Decimal numbers must have decimal points and not commas in the text (except in the Serbian abstract), tables 
and axis labels in graphical presentations of results. 

ARTICLE STRUCTURE 

• TITLE PAGE 
• MAIN TEXT 
• TABLE CAPTIONS 
• TABLES (each on a separate page) 
• FIGURE and/or SCHEME CAPTIONS 
• FIGURES and/or SCHEMES (each on a separate page) 

Title page.  
Title in bold letters, should be clear and concise, preferably 12 words or less. The use of non-standard 

abbreviations, symbols and formulae is discouraged.  
AUTHORS’ NAMES in capital letters with the full first name, initials of further names separated by a space 

and surname. Commas should separate the author’s names except for the last two names when ‘and’ is to be used. In 
multi-affiliation manuscripts, the author’s affiliation should be indicated by an Arabic number placed in superscript 
after the name and before the affiliation. Use * to denote the corresponding author(s).  

Affiliations should be written in italic. The e-mail address of the corresponding author should be given after the 
affiliation(s).  

Abstract: A one-paragraph abstract written of 150–200 words in an impersonal form indicating the aims of the 
work, the main results and conclusions should be given and clearly set off from the text. Domestic authors should also 
submit, on a separate page, an Abstract – Izvod, the author’s name(s) and affiliation(s) in Serbian (Latin letters). For 
authors outside Serbia, the Editorial Board will provide a Serbian translation of their English abstract.  

Keywords: Up to 6 keywords should be given. Do not use words appearing in the manuscript title  
RUNNING TITLE: A one line (maximum five words) short title in capital letters should be provided. 

Main text. The main text should have the form:  
INTRODUCTION,  
EXPERIMENTAL (RESULTS AND DISCUSSION),  
RESULTS AND DISCUSSION (EXPERIMENTAL),  
CONCLUSIONS,  
NOMENCLATURE (optional),  
Acknowledgements: If any,  
REFERENCES (Citation of recent papers published in chemistry journals that highlight the significance of 

work to the general readership is encouraged.) 

The sections should be arranged in a sequence generally accepted for publication in the respective fields. They 
subtitles should be in capital letters, centred and NOT numbered. 

The INTRODUCTION should include the aim of the research and a concise description of background 
information and related studies directly connected to the paper.  

The EXPERIMENTAL section should give the purity and source of all employed materials, as well as details of 
the instruments used. The employed methods should be described in sufficient detail to enable experienced persons to 
repeat them. Standard procedures should be referenced and only modifications described in detail. On no account 
should results be included in the experimental section.  

The RESULTS AND DISCUSSION should include concisely presented results and there significance discussed 
and compared to relevant literature data. The results and discussion may be combined or kept separate.  

The inclusion of a CONCLUSION section, which briefly summarizes the principal conclusions, is highly 
recommended. NOMENCLATURE is optional but, if the authors wish, a list of employed symbols may be included.  

REFERENCES should be numbered sequentially as they appear in the text. When cited in the text, the reference 
number should be superscripted in Font 12, following any punctuation mark. In the reference list, they should be in 
normal position followed by a full stop. Reference entry must not be formatted using Carriage returns (enter key;   
key) or multiple space key. The formatting of references to published work should follow the Journal’s style as 
follows: 



 

Journals*: 1. A. B. Surname1, C. D. Surname2, J. Serb. Chem. Soc. Vol. (Year) first page Number 

Books: 2. A. B. Surname1, C. D. Surname2, Name of Book, Publisher, City, Year, p. 100 

Compilations: 3. A. B. Surname1, C. D. Surname2, in: Name of Compilation, A. B. Editor1, C. D. Editor2, Ed(s)., 
Publisher, City, Year, p. 100

Proceedings: 4. A. B. Surname1, C. D. Surname2, , in: Proceeding of Name of the Conference or Symposium, 
Title of the Proceeding, (Year of publishing), Place of the Conference, Country, Year, p. 100 

Patents: 5. A. B. Inventor1, C. D. Inventor2, (Holder), Country Code and patent number (registration year) 

Chemical  
Abstracts: 

6. A. B. Surname1, C. D. Surname2, Chem. Abstr. CA 234 567a 
For non-readily available literature, the Chemical Abstracts reference should be given in square 
brackets: [C.A. 139/2003 357348t] after the reference

Standards: 7. EN ISO 250: Name of the Standard (Year)

Websites: 8. Title of the website, URL in full (date accessed)

* International Library Journal abbreviation is required. Please consult e.g. http://www.library.ubc.ca/scieng/coden.html 

Only the last entry in the reference list should end with a full stop. 
The names of all authors should be given in the list of references; the abbreviation et al. may only be used in the 

text. The original journal title is to be retained in the case of publications published in any language other than English 
(please denote the language in parenthesis after the reference). Titles of publications in non-Latin alphabets should be 
transliterated. Russian references are to be transliterated using the following transcriptions:  

ж→zh,  ҳ→kh,  ц→ts,  ч→ch,  ш→sh,  щ→shch,  ы→y,  ю→yu,  я→ya,  э→e,  й→i,  ь→’. 

Table Captions. A separate list of table captions, which makes the tables comprehensible without reference to 
the text, should be provided in numerical order on a separate page. 

Tables. Tables are part of the text but must be given on separate pages. The tables should be numbered 
consequently in Roman numbers. Quantities should be separated from units by a slash (/). Footnotes to tables, in size 
10 font, are to be indicated consequently (line-by-line) in superscript letters. Tables should be prepared with the aid of 
the WORD table function, without vertical lines. The minimum size of the font in the tables should be 10 pt. Table 
columns must not be formatted using multiple spaces. Table rows must not be formatted using Carriage returns (enter 
key;   key). Tables should not be incorporated as graphical objects. In setting up tables, Authors should keep in mind 
the area of the Journal’s page (12.5 cm × 19 cm) and should make tables conform to the limitations of these 
dimensions. 

Figure and/or Scheme Captions. A separate list of figure and/or scheme captions, which makes the figures 
and/or schemes comprehensible without reference to the text, should be provided in numerical order on a separate 
page. 

Figures and/or Schemes. Figures and/or Schemes (of moderate resolution) should follow the captions, each on 
a separate page of the manuscript. High resolution illustrations in TIF or EPS format (JPG format is acceptable for 
colour and greyscale photos, only) must be uploaded as a separate archived (.zip, .rar or .arj) file. 

Figures and/or Schemes should be prepared according to the ARTWORK INSTRUCTIONS! 

Mathematical and chemical equations must be numbered, Arabic numbers, consecutively in parenthesis at the 
end of the line. All equations should be embedded in the text except when they contain graphical elements (tables, 
figures, schemes and formulae). Complex equations (fractions, inegrals, matrix…) should be prepared with the aid of 
the WORD Equation editor. 

Reporting analytic and spectral data 
Adequate evidence to enable the identity and purity of all newly synthesized compounds should be provided. 
The styles for the presentation of analytical and spectral data, which should be strictly adhered to (including the 

order), are as follows: 
Compound (3a). Yield: 60 %; m.p. 120 °C. Anal. Calcd. for C30H23N3O5: C, 71.27; H 4.58; N, 8.31. Found: C, 

71.30, H, 4.54, N, 8.70. IR (KBr, cm-1): 1535, 1469 (C=C– stretching of aromatic ring), 1680s (–C=O stretching of -
COOH group), 3128 (–NH stretching of secondary amine). 1H-NMR (200 MHz, DMSO-d6, δ / ppm): 1.38–1.39 (3H, 
t, –CH2–CH3), 4.0–4.49 (2H, q, –CH2–CH3), 10.92 (1H, s, –NH, D2O exchangeable), 7.75 (2H, t, aromatic, J = 7.8 
Hz), 2.26–2.75 (2H, m, –CH2). 

13C-NMR (100 MHz, CDCl3, δ / ppm): 157.76 (C1), 146.89 (C2), 177.69 (–COO), 
33.44 (–CH), 38.55 (–CH2). MS (m/z, (relative abundance, %)): 252 (M+, 32.5) 225, 213, 211 (BP, 100). UV–Vis 
(EtOH) (λmax / nm, eV or cm-1 (ε / L mol-1 cm-1)): 205 (2300), 243 (1800). Optical rotation values, α (589 nm, 20 °C, 10 
g dm-3 in H2O, 10 cm): +66.470°. Specific rotation [α]20

589 / deg dm-1 g-1 cm3. Magnetic moment, μeff / μB: 3.1. 
Deposition of crystallographic data 
Prior to submission, the crystallographic data included in a manuscript presenting such data should be deposited 

at the appropriate database. Crystallographic data associated with organic and metal-organic structures should be 
deposited at the Cambridge Crystallographic Data Centre (CCDC) by e-mail to deposit@ccdc.cam.ac.uk 

Crystallographic data associated with inorganic structures should be deposited with the Fachin-
formationszentrum Karlsruhe (FIZ) by e-mail to crysdata@fiz-karlsruhe.de. A deposition number will then be 
provided, which should be added to the reference section of the manuscript. 



ARTWORK INSTRUCTIONS 

JSCS accepts only TIFF or EPS formats, as well as JPEG format (only for colour and greyscale photographs) 
for electronic artwork and graphic files. MS files (Word, PowerPoint, Excel, Visio) NOT acceptable. Generally, 
scanned instrument data sheets should be avoided. Authors are responsible for the quality of their submitted artwork. 
Every single Figure or Scheme, as well as any part of the Figure (A, B, C…) should be prepared according to 
following instructions (every part of the figure, A, B, C…, must be submitted as an independent single graphic file). 

TIFF 
Virtually all common artwork and graphic creation software is capable of saving files in TIFF format. This 

“option” can normally be found under the “Save As...” or “Export...” commands in the “File” menu. TIFF (Tagged 
Image File Format) is the recommended file format for bitmap, greyscale and colour images. Colour images should be 
in the RGB mode. When supplying TIFF files, please ensure that the files are supplied at the correct resolution: 

Line artwork: minimum of 1000 dpi 
RGB image: minimum of 300 dpi 
Greyscale image: minimum of 300 dpi  
Combination artwork (line/greyscale/RGB): minimum of 500 dpi 
Images should be tightly cropped. 
If applicable, please re-label artwork with a font supported by JSCS (Arial, Helvetica, Times, Symbol) and 

ensure it is of an appropriate font size. Save an image in TIFF format with LZW compression applied. It is 
recommended to remove Alpha channels before submitting TIFF files. It is recommended to flatten layers before 
submitting TIFF files. 

EPS 
Virtually all common artwork creation software, such as Canvas, ChemDraw, CorelDraw, SigmaPlot, Origin 

Lab…, are capable of saving files in EPS format. This “option” can normally be found under the “Save As...” or 
“Export...” commands in the “File” menu. For vector graphics, EPS (Encapsulated PostScript) files are the preferred 
format as long as they are provided in accordance with the following conditions: when they contain bitmap images, 
the bitmaps should be of good resolution (see instructions for TIFF files). 

JPEG 
JPEG (Joint Photographic Experts Group) is the acceptable file format only for colour and greyscale 

photographs. JPEG can be created with respect to photo quality (low, medium, high; from 1 to 10), ensuring file sizes 
are kept to a minimum to aid easy file transfer. Images should have a minimum resolution of 300 dpi. Image width: 
minimum 8.0 cm; maximum 12.0 cm. 

When colour is involved, it should be encoded as RGB. An 8-bit preview/header at a resolution of 72 dpi should 
always be included. Embed fonts should be always included and only the following fonts should be used in artwork: 
Arial, Helvetica, Times, Symbol. The vertical space between the parts of an illustration should be limited to the bare 
necessity for visual clarity. No data should be present outside the actual illustration area. Line weights should range 
from 1 pt to 2 pt. When using layers, they should be reduced to one layer before saving the image (Flatten Artwork). 

Sizing of artwork 
JSCS aspires to have a uniform look for all artwork contained in a single article. Hence, it is important to be 

aware of the style of the journal. Figures should be submitted in black and white or, if required, colour (charged). If 
coloured figures or photographs are required, this must be stated in the cover letter and arrangements made for 
payment through the office of the Serbian Chemical Society. As a general rule, the lettering on an artwork should 
have a finished, printed size of 11 pt for normal text and no smaller than 7 pt for subscript and superscript characters. 
Smaller lettering will yield a text that is barely legible. This is a rule-of-thumb rather than a strict rule. There are in-
stances where other factors in the artwork, (for example, tints and shadings) dictate a finished size of perhaps 10 pt. 
Lines should be of at least 1 pt thickness. When deciding on the size of a line art graphic, in addition to the lettering, 
there are several other factors to address. These all have a bearing on the reproducibility/readability of the final 
artwork. Tints and shadings have to be printable at the finished size. All relevant detail in the illustration, the graph 
symbols (squares, triangles, circles, etc.) and a key to the diagram (to explain the explanation of the graph symbols 
used) must be discernible. The sizing of halftones (photographs, micrographs,...) normally causes more problems than 
line art. It is sometimes difficult to know what an author is trying to emphasize on a photograph, so you can help us by 
identifying the important parts of the image, perhaps by highlighting the relevant areas on a photocopy. The best 
advice that can be given to graphics suppliers is not to over-reduce halftones. Attention should also be paid to magni-
fication factors or scale bars on the artwork and they should be compared with the details inside. If a set of artwork 
contains more than one halftone, again please ensure that there is consistency in size between similar diagrams. 

General sizing of illustrations which can be used for the Journal of the Serbian Chemical Society:  
Fig. size: Minimum 30 mm width; Small - 60 mm width; Large - 90 mm width; Maximum - 120 mm width 

Pixel requirements (width) per print size and resolution for bitmap images: 
 Image width A B C
Minimal size 30 mm 354 591 1181
Small size 60 mm 709 1181 2362
Large size 90 mm 1063 1772 3543
Maximal size 120 mm 1417 2362 4724

A: 300 dpi > RGB or Greyscale image; B: 500 dpi >   Combination artwork (line/greyscale/RGB); C: 1000 dpi> Line artwork 
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